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Kit Contents 

Investigator ESSplex SE GO! Kit (200) (1000) 

Catalog no. 381566 381568 

Number of 25 μl reactions 200 1000 

Fast Reaction Mix* 1500 μl 5 x 1500 μl 

Primer Mix ESSplex SE GO! 2 x 1750 μl 10 x 1750 μl 

Control DNA 9948 (5 ng/μl) 50 μl 50 μl 

DNA size standard 550 (BTO) 110 μl 5 x 110 μl 

Allelic ladder ESSplex SE GO! 50 μl 5 x 50 μl 

Quick-Start Protocol 1 1 
 

* Contains HotStarTaq® Plus DNA Polymerase, dNTPs, MgCl2, and bovine serum albumin 
(BSA). 

Storage 
The Investigator ESSplex SE GO! Kit is shipped on dry ice. It should be stored 
immediately upon receipt at –30 to –15°C in a constant-temperature freezer. 
Avoid repeated thawing and freezing. Primer mix and allelic ladder must be 
stored protected from the light. DNA samples and post-PCR reagents (allelic 
ladder and DNA size standard) should be stored separately from the PCR 
reagents. Under these conditions, the components are stable until the expiration 
date indicated on the kit. 

Once opened, the Investigator ESSplex SE GO! Kit should be stored at 2–8°C 
for a maximum of 2 weeks. 

Intended Use 
The Investigator ESSplex SE GO! Kit is intended for molecular biology 
applications in forensic, human identity, and paternity testing. This product is 
not intended for the diagnosis, prevention, or treatment of a disease. 

All due care and attention should be exercised in the handling of the products. 
We recommend all users of QIAGEN products to adhere to the NIH guidelines 
that have been developed for recombinant DNA experiments, or to other 
applicable guidelines. 
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Safety Information 
When working with chemicals, always wear a suitable lab coat, disposable 
gloves, and protective goggles. For more information, please consult the 
appropriate safety data sheets (SDSs). These are available online in convenient 
and compact PDF format at www.qiagen.com/safety where you can find, view, 
and print the SDS for each QIAGEN kit and kit component. 

Quality Control  
In accordance with QIAGEN’s ISO-certified Quality Management System, each 
lot of Investigator ESSplex SE GO! Kit is tested against predetermined 
specifications to ensure consistent product quality.  
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Introduction 
The Investigator ESSplex SE GO! Kit is used for multiplex PCR in forensic human 
identity and paternity testing. The 15 polymorphic STR markers recommended 
by the European Network of Forensic Science Institutes (ENFSI) and the 
European DNA Profiling Group (EDNAP) as the new European Standard Set of 
loci (D1S1656, D2S441, D2S1338, D3S1358, D8S1179, D10S1248, 
D12S391, D16S539, D18S51, D19S433, D21S11, D22S1045, FGA [FIBRA], 
TH01 [TC11], and vWA), plus SE33 [ACTBP2], and the gender-specific 
Amelogenin are amplified simultaneously. 

The Investigator ESSplex SE GO! Kit has been developed specifically for rapid 
direct amplification from blood or buccal cells on FTA™ and other paper, and 
buccal swabs. The kit utilizes QIAGEN’s fast cycling PCR technology, which 
allows amplification in around 45 minutes and provides highly robust results. 
Punches from FTA and other filter papers can be used without the need for 
pretreatment. For buccal swabs, a fast and convenient room temperature lysis 
protocol is provided to create a crude lysate for amplification. The primers are 
fluorescence-labeled with one of the following dyes: 

 6-FAM™: Amelogenin, TH01, D3S1358, vWA, D21S11 

 BTG: D16S539, D1S1656, D19S433, SE33 

 BTY: D10S1248, D22S1045, D12S391, D8S1179, D2S1338 

 BTR: D2S441, D18S51, FGA 

The recommended amount of sample is one punch of 1.2 mm diameter for FTA 
and other filter papers, or 2 μl of a buccal swab lysate. 

The Investigator ESSplex SE GO! Kit was validated using the GeneAmp® PCR 
System 9700 (with Gold-plated 96-Well Silver Block) and the Applied 
Biosystems® 3500™ Genetic Analyzer. 

Table 1 shows the STR loci with their chromosomal mapping and repeat motifs, 
which are concordant with the International Society for Forensic Genetics (ISFG) 
guidelines for the use of microsatellite markers (Bär et al., 1997). 

For information about known microvariants not contained in the Investigator 
ESSplex SE GO! Allelic Ladder, see the National Institute of Standards and 
Technology (NIST) web site (www.cstl.nist.gov/biotech/strbase/). 
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Table 1. Locus-specific information of the Investigator ESSplex SE GO! Kit 

 
 
Locus 

GenBank® 
accession 
number 

 
Repeat motif of the 
reference allele 

 
Chromosomal 
mapping 

Amelogenin X M55418 – Xp22.1-22.3 

Amelogenin Y M55419 – Yp11.2 

D1S1656 NC_000001.9 [TAGA]16 

[TGA][TAGA][TAGG]1[TG]5
1q42 

D2S441 AL079112 [TCTA]12 2p14 

D2S1338 G08202 [TGCC]6[TTCC]11 2q35 

D3S1358 11449919 TCTA [TCTG]2 [TCTA]15 3p25.3 

D8S1179 G08710 [TCTA]12 8q23.1-23.2 

D10S1248 AL391869 [GGAA]13 10q26.3 

D12S391 G08921 [AGAT]5 GAT [AGAT]7 

[AGAC]6 AGAT 12p13.2 

D16S539 G07925 [GATA]11 16q24.1 

D18S51 L18333 [AGAA]13 18q21.3 

D19S433 G08036 AAGG [AAAG] AAGG 
TAGG [AAGG]11 

19q12 

D21S11 AP000433 
[TCTA]4 [TCTG]6 [TCTA]3 

TA [TCTA]3 TCA [TCTA]2 

TCCATA [TCTA]11 

21q21.1 

D22S1045 AL022314 [ATT]14 ACT [ATT]2 22q12.3 

FGA (FIBRA) M64982 
[TTTC]3 TTTTTTCT [CTTT]13 
CTCC [TTCC]2 

4q28.2 

SE33 
(ACTBP2) NG000840 

[AAAG]9 AA 

[AAAG]16 
6q14.2 

TH01 (TC11) D00269 [TCAT]9 11p15.5 

vWA M25858 TCTA [TCTG]4 [TCTA]13  12p13.31 
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Equipment and Reagents to Be Supplied by User 
When working with chemicals, always wear a suitable lab coat, disposable 
gloves, and protective goggles. For more information, consult the appropriate 
safety data sheets (SDSs), available from the product supplier. 

All protocols 

 Hi-Di™ Formamide, 25 ml (Applied Biosystems, cat. no. 4311320) 

 Matrix Standards BT5 for single-capillary instruments, e.g., ABI PRISM® 
310 Genetic Analyzer (QIAGEN, cat. no. 386113) 

 Matrix Standards BT5 for multi-capillary instruments, e.g., ABI PRISM 3100 
and Applied Biosystems 3130 and 3500 Genetic Analyzers (QIAGEN, 
cat. nos. 386123 or 386125) 

 Pipets and pipet tips 

 One of the following DNA analyzers:* 
ABI PRISM 310 Genetic Analyzer 
ABI PRISM 3100-Avant™/3100 Genetic Analyzer 
Applied Biosystems 3130/3130xl Genetic Analyzer 
Applied Biosystems 3500/3500xL Genetic Analyzer 

 One of the following PCR thermal cyclers:*  
QIAGEN Rotor-Gene® Q 
GeneAmp PCR System 9700 
Bio-Rad PTC-200 
Biometra UNO-Thermoblock 
Eppendorf® Mastercycler® ep 

 PCR tubes or plates 

 Microcentrifuge for PCR tubes or plates 

For protocols based on blood or buccal cells on paper 

 Uni-Core Punch 1.2 mm (GE Healthcare, cat. no. WB100028) or 1.2 mm 
Aluminum Micro-Punch with Mat (GE Healthcare, cat. no. WB100005) 

For protocols based on buccal cells on paper 

 Investigator STR GO! Punch Buffer (1000) or (200) (cat. no. 386528 or 
386526) 

 

* This is not a complete list of suppliers and does not include many important vendors of 
biological supplies. 
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For protocols based on buccal swab lysates 

 Investigator STR GO! Lysis Buffer (QIAGEN, cat. no. 386516) 

 2 ml microcentrifuge tubes 

 Shaker for 2 ml microcentrifuge tubes 

Validity analysis software for human identification products 

Investigator Human Identification PCR Kits require calibration with an allelic 
ladder. Therefore, the software used must be compatible with human 
identification (HID) products for forensic applications. We recommend 
GeneMapper® ID-X, GeneMapper ID, or Genotyper® Software. The Investigator 
Template Files facilitate data analysis and are valid with the software mentioned 
above. 
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Important Notes 
The experimental conditions outlined in the protocols have been found to give 
the best results. However, depending on the sample material, PCR cycle 
numbers may be adapted to ensure the highest possible first round success 
rates. We recommend running a representative batch of samples in order to 
confirm that the cycle numbers given in this protocol are optimal. Increase the 
cycle number by one if the signals in the resulting electropherograms are too 
low. Decrease the cycle number by one if the signals in the resulting 
electropherograms are too high. 
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Protocol: PCR Amplification from Blood on FTA and Other 
Paper 
This protocol is for direct PCR amplification of STR loci from punches of blood 
on FTA and other paper using the Investigator ESSplex SE GO! Kit. 

Important points before starting 

 Set up all reaction mixtures in an area separate from that used for DNA 
isolation and PCR product analysis (post-PCR). 

 Use disposable tips containing hydrophobic filters to minimize cross-
contamination risks. 

Things to do before starting 

 Before opening the tubes containing PCR components, vortex and then 
centrifuge briefly to collect the contents at the bottom of the tubes. 

Procedure 

1. Take a 1.2 mm punch from the center of the blood spot with a suitable tool 
(e.g., Uni-Core Punch). 
Important: Do not use more than one punch at a time. 

2. Prepare a master mix according to Table 2. 
As some loss of reagents can occur during transfers, prepare the mix with 
additional reactions included. Also include positive and negative control 
reactions. The master mix contains all of the components needed for PCR 
except the template (sample) DNA. 

3. Mix the reaction mix thoroughly, and dispense 25 μl into PCR tubes or the 
well of a PCR plate. 

4. Transfer one 1.2 mm disc to each reaction.  
Note: Do not mix the reaction after disc transfer. 

5. Prepare positive and negative controls. 
Positive control: Use 2 μl of the Control DNA (i.e., 10 ng). 

Note: Amounts of Control DNA may have to be adapted after setting 
optimal PCR cycle number in your laboratory if signals are too low or too 
high. 

Negative control: Do not add any template DNA. Do not add a blank disc 
or water to the negative control well. 

6. Briefly centrifuge reactions to ensure discs are fully submerged. 
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7. Program the thermal cycler according to the manufacturer’s instructions, 
using the conditions given in Table 3. 
Note: If using the GeneAmp 9700 thermal cycler with an Aluminum block, 
use “Std Mode”, or with a Silver block or Gold-plated Silver block, use 
“Max Mode”. Do not use “9600 Emulation Mode”. 

8. After the cycling protocol is completed, store samples at –30 to –15°C 
protected from the light, or proceed directly with running the 
electrophoresis. 

Table 2. Master Mix setup 

Component Volume per reaction 

Fast Reaction Mix  7.5 μl 

Primer Mix 17.5 μl 

Total volume  25 μl 
 

Table 3. Cycling protocol for blood on FTA and other paper  

Temperature Time Number of cycles 

95°C* 8 min – 

96°C 

61°C 

10 s 

38 s 

 

25 

68°C 

10°C 

1 min 

 

– 

– 
 

* Hot-start to activate DNA polymerase. 
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Protocol: PCR Amplification from Buccal Cells on FTA and 
Other Paper 
This protocol is for direct PCR amplification of STR loci from punches of buccal 
cells on FTA and other paper using the Investigator ESSplex SE GO! Kit. 

Important points before starting 

 Set up all reaction mixtures in an area separate from that used for DNA 
isolation and PCR product analysis (post-PCR). 

 Use disposable tips containing hydrophobic filters to minimize cross-
contamination risks. 

Things to do before starting 

 Before opening the tubes containing PCR components, vortex and then 
centrifuge briefly to collect the contents at the bottom of the tubes. 

Procedure 

1. Take a 1.2 mm punch with a suitable tool (e.g., Uni-Core Punch). 
Note: If using a Whatman EasiCollect™ and a buccal cell sample, take the 
punch from a whitish area. This color indicates successful sample transfer. 

Important: Do not use more than one punch at a time. 

2. Prepare a master mix according to Table 4. 
As some loss of reagents can occur during transfers, prepare the mix with 
additional reactions included. Also include positive and negative control 
reactions. The master mix contains all of the components needed for PCR 
except the template (sample) DNA. 

3. Mix the reaction mix thoroughly, and dispense 27 μl into PCR tubes or the 
well of a PCR plate. 

4. Transfer one 1.2 mm disc to each reaction.  
Note: Do not mix the reaction after disc transfer. 
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5. Prepare positive and negative controls. 
Positive control: Use 1 μl Control DNA (i.e., 5 ng). 

Note: Amounts of Control DNA may have to be adapted after setting 
optimal PCR cycle number in your laboratory if signals are too low or too 
high. 

Negative control: Do not add any template DNA. Do not add a blank disc 
or water to the negative control PCR tube or well. 

6. Briefly centrifuge reactions to ensure discs are fully submerged. 
7. Program the thermal cycler according to the manufacturer’s instructions, 

using the conditions given in Table 5 . 
Note: If using the GeneAmp 9700 thermal cycler with an Aluminum block, 
use “Std Mode”, or with a Silver block or Gold-plated Silver block, use 
“Max Mode”. Do not use “9600 Emulation Mode”. 

8. After the cycling protocol is completed, store samples at –30 to –15°C 
protected from the light, or proceed directly with running the 
electrophoresis. 

Table 4. Master Mix setup for buccal cells on FTA and other paper 

Component Volume per reaction 

Fast Reaction Mix  7.5 μl 

Primer Mix 17.5 μl 

Investigator STR GO! Punch Buffer 2.0 μl 

Total volume  27.0 μl 
 

Table 5. Cycling protocol for buccal cells on FTA and other paper  

Temperature Time Number of cycles 

95°C* 8 min – 

96°C 

61°C 

10 s 

38 s 

 

28 

68°C 

10°C 

1 min 

 

– 

– 
 

* Hot-start to activate DNA polymerase. 
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Protocol: PCR Amplification from Buccal Swab Lysates 
This protocol is for direct PCR amplification of STR loci from crude lysates of 
buccal swabs using the Investigator ESSplex SE GO! Kit. 

Important points before starting 

 Set up all reaction mixtures in an area separate from that used for DNA 
isolation and PCR product analysis (post-PCR). 

 Use disposable tips containing hydrophobic filters to minimize cross-
contamination risks. 

Things to do before starting 

 Before opening the tubes containing PCR components, vortex and then 
centrifuge briefly to collect the contents at the bottom of the tubes. 

Procedure 

1. Place the swab in a 2 ml microcentrifuge tube.  
Carefully cut, break off, or eject the end part of the swab. 

Note: Prepare a blank swab as negative control. 

2. Add 500 μl of STR GO! Lysis Buffer to the sample. 
3. Incubate at room temperature for 5 min with shaking at 1200 rpm in a 

thermomixer. 
Optional: For challenging samples results may be improved by incubating at 
95°C with shaking at 1200 rpm. 

4. Prepare a master mix according to Table 6. 
As some loss of reagents can occur during transfers, prepare the mix with 
additional reactions included. Also include positive and negative control 
reactions. The master mix contains all of the components needed for PCR 
except the template (sample) DNA. 

5. Mix the reaction mix thoroughly, and dispense 25 μl into PCR tubes or the 
well of a PCR plate. 

6. Transfer 2 μl of swab lysate to each reaction.  
7. Prepare positive and negative controls. 

Positive control: Use 1 μl Control DNA (i.e., 5 ng). 

Note: Amounts of Control DNA may have to be adapted after setting 
optimal PCR cycle number in your laboratory if signals are too low or too 
high. 
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Negative control: Use a blank swab lysate. 

8. Program the thermal cycler according to the manufacturer’s instructions, 
using the conditions given in Table 7. 
Note: If using the GeneAmp 9700 thermal cycler with an Aluminum block, 
use “Std Mode”, or with a Silver block or Gold-plated Silver block, use 
“Max Mode”. Do not use “9600 Emulation Mode”. 

9. After the cycling protocol is completed, store samples at –30 to –15°C 
protected from the light, or proceed directly with running the 
electrophoresis. 

Table 6. Master Mix setup 

Component Volume per reaction 

Fast Reaction Mix  7.5 μl 

Primer Mix 17.5 μl 

Total volume  25 μl 
 

Table 7. Cycling protocol for buccal swab lysates  

Temperature Time Number of cycles 

95°C* 8 min – 

96°C 

61°C 

10 s 

38 s 

 

28 

68°C 

10°C 

1 min 

 

– 

– 
 

* Hot-start to activate DNA polymerase. 
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Protocol: Electrophoresis Using the ABI PRISM 310 Genetic 
Analyzer 
For general instructions on instrument setup, matrix generation, and application 
of the GeneScan® or GeneMapper® ID Software, refer to the ABI PRISM 310 
Genetic Analyzer User’s Manual. Electrophoresis using the GeneScan Software 
is described below.  

The virtual filter set G5 is used for combined application of the 5 fluorescent 
labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is known as BT5.  

The materials required for electrophoresis are given in Table 8. 

Table 8. Materials required for electrophoresis 

Material Specifications 

Capillary 47 cm/50 μm (green) 

Polymer POP-4™ for ABI PRISM 310 Genetic Analyzer 

Buffer 10x Genetic Analyzer Buffer with EDTA 
 

Matrix generation 
Before conducting DNA fragment size analysis with the filter set G5, a matrix 
with the 5 fluorescent labels 6-FAM, BTG, BTY, BTR, and BTO must be 
generated (Table 9).  

Table 9. The 5 fluorescent labels of BT5 

Color Matrix standard 

Blue (B) 6-FAM 

Green (G) BTG 

Yellow (Y) BTY 

Red (R) BTR 

Orange (O) BTO 
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1. Five electrophoresis runs should be conducted, one for each fluorescent 
label, under the same conditions as for the samples and allelic ladders of the 
Investigator ESSplex SE GO! Kit, in order to generate suitable matrix files 
(Table 10).  

Table 10. Matrix setup for a single capillary instrument (ABI PRISM 310 Genetic 
Analyzer) 

Matrix sample Component Volume 

Matrix sample 1 Hi-Di Formamide 

Matrix standard 6-FAM 

12.0 μl 

1.0 μl 

Matrix sample 2 Hi-Di Formamide 

Matrix standard BTG 

12.0 μl 

1.0 μl 

Matrix sample 3 Hi-Di Formamide 

Matrix standard BTY 

12.0 μl 

1.0 μl 

Matrix sample 4 Hi-Di Formamide 

Matrix standard BTR 

12.0 μl 

1.0 μl 

Matrix sample 5 Hi-Di Formamide 

Matrix standard BTO 

12.0 μl 

1.0 μl 
 

 

2. Denature for 3 min at 95°C. 
3. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

4. Load the samples on the tray. 
5. Create a Sample Sheet and enter the sample designation. Table 11 shows 

the injection list for the matrix generation. 
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Table 11. Injection list for matrix generation 

Parameter Settings 

Module File GS STR POP-4 (1 ml) G5 

Matrix File None 

Size Standard None* 

Injection Time (s) 5 

Injection Voltage (kV) 15 

Run Voltage (kV) 15 

Run Temperature (°C) 60 

Run Time (min) 24 
 

* Always prepare matrix standards without DNA Size Standard (BTO). 

Procedure 

1. Run the GeneScan Software. 
2. Select “New” from the File menu, and then select “Project”.  
3. Open the folder of the current run and select “Add Sample Files”. 
4. Select a matrix sample in the “Sample File” column. 
5. Click “Sample” and then “Raw Data”. 
6. Check the matrix samples for a flat baseline. As shown in the figure (next 

page), there should be at least 5 peaks with peak heights of 1000–4000 
RFU for each matrix sample. 
Note: The optimal range is 2000–4000 RFU. 
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Electropherogram with raw data of the matrix standard 6-FAM. 

 

7. Select an analysis range with a flat baseline and re-inject the matrix sample, 
if necessary. 

8. Record start and end value (data points) of the analysis range; e.g., start 
value 3200, end value 5500. 

9. Calculate the difference between the end and start values; e.g., 5500–
3200=2300 data points. 

Generation of a matrix 

1. Select “New” in the File menu, and then select “Matrix”. 
2. Import the matrix samples for all dyes (B, G, Y, R, and O). 
3. Enter a “Start At” value, e.g., 3200. 
4. Under “Points”, enter the calculated difference between end and start 

values, e.g., 2300. 
5. Click “OK” to calculate the new matrix. 

 

 
Matrix sample selection. 

 

▼ 3200 data points (X) 
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6. Select “Save as” in the File menu to save the new matrix in the matrix 
folder. 
 

 
New matrix BT5. 

Checking the matrix 

1. To check the new matrix with current samples, select “New” in the File 
menu, and then select “Project”. 

2. Open the folder of the respective run and select “Add Sample Files”. 
3. Select the sample(s) in the Sample File column. 
4. Click “Sample” and then “Install New Matrix” to open the matrix folder and 

select the new matrix. 
5. Re-analyze the samples. 

Note: There should be no pull-up peaks between the dye panels (B, G, Y, R, 
O) with the new matrix. 

 

Sample preparation 
1. Set up a mixture of formamide and DNA size standard according to Table 

12. 

Table 12. Setup of formamide and DNA size standard mixture 

Component Volume per sample 

Hi-Di Formamide 12.0 μl 

DNA Size Standard 550 (BTO) 0.5 μl 
 

 

2. Aliquot 12 μl of the mixture to a tube for each sample to be analyzed. 
3. Add 1 μl PCR product or allelic ladder (diluted, if necessary). 
4. Denature for 3 min at 95°C. 
5. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 
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6. Load the samples on the tray. 

Setting up the GeneScan Software 
Create a Sample Sheet and enter sample designation. 

Table 13. Injection list for ABI PRISM 310 Genetic Analyzer 

Component Settings 

Module File GS STR POP-4 (1 ml) G5 

Matrix File e.g., Matrix BT5 

Size Standard e.g., SST-BTO_60-500bp 

Injection Time (s)  5* 

Injection Voltage (kV) 15 

Run Voltage (kV) 15 

Run Temperature (°C) 60 

Run Time (min) 28† 
 

* Deviating from standard settings, the injection time may range between 1 and 10 s 
depending on the type of sample. If samples with very high signal intensities are recorded, a 
shorter injection time may be selected. For samples with low DNA content, an injection time 
up to 10 s may be necessary.  

† D he run time for Investigator ESSplex SE GO! was modified in order to be able to analyze 
fragments with lengths of up to 500 bp. 
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Analysis parameters 
Table 14 lists the recommended analysis parameters. 

Table 14. Recommended analysis parameters for the ABI PRISM 310 Genetic 
Analyzer 

Parameter Settings 

Analysis Range Start: 2000 

Stop: 10,000 

Data Processing Baseline: Checked 

Multi-component: Checked 

Smooth options: Light 

Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 

G:*   R:* 

O:* 

Min. Peak Half Width: 2 pts 

Polynomial Degree: 3 

Peak Window Size: 11 pts† 

Size Call Range Min: 60 

Max: 550 

Size Calling Method Local Southern Method 

Split Peak Correction None 
 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be 
detected by the GeneScan or GeneMapper ID Software. Thresholds are usually 50–200 RFU 
and should be determined individually by the laboratory. Recommendation: The minimal peak 
height should be 3-times as high as the background noise of the baseline. 

† Only the setting for Peak Window Size is different to defaults from Applied Biosystems for 
HID analysis. 

 
Note: For information on the use of the recommended Template Files (as 
analysis parameters), refer to the appropriate Investigator Template Files 
User Guide (Genotyper®, GeneMapper ID, or GeneMapper ID-X).  
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Protocol: Electrophoresis using the ABI PRISM 3100-
Avant/3100 Genetic Analyzer 
For detailed instructions on instrument setup, spectral calibration, application of 
the ABI PRISM 3100 Data Collection software version 1.01 or 1.1 and the 
GeneScan software, refer to the ABI PRISM 3100-Avant/3100 Genetic 
Analyzer User’s Manual.  

The system with 4 capillaries is the ABI PRISM 3100-Avant Genetic Analyzer 
and the system with 16 capillaries is the ABI PRISM 3100 Genetic Analyzer.  

The virtual filter set G5 is used for combined application of the 5 fluorescent 
labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is known as BT5.  

The materials required for electrophoresis are given in Table 15. 

Table 15. Materials required for electrophoresis 

Material Specifications 

Capillary 36 cm Capillary Array for ABI PRISM 3100-
Avant/3100 Genetic Analyzer 

Polymer POP-4 Polymer for ABI PRISM 3100-Avant/3100 
Genetic Analyzer 

Buffer 10x Genetic Analyzer Buffer with EDTA 
 

Spectral calibration/matrix generation 
Proper spectral calibration is critical for evaluation of multicolor systems with the 
ABI PRISM 3100/3100-Avant Genetic Analyzer and should be done before 
conducting fragment length analysis. The calibration procedure creates a matrix 
which is used to correct the overlapping of fluorescence emission spectra of the 
dyes.  

Spectral calibration comprises the following steps: 

 Preparation of the spectral calibration standards 

 Loading the standards to the 96-well reaction plate (one sample per 
capillary) 

 Entering the plate composition 

 Performing a spectral calibration run and checking the matrix 
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Preparing the spectral calibration standards 

Example for 4 capillaries (ABI PRISM 3100-Avant Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to Table 
16. 

Table 16. Setup of formamide and Matrix Standard BT5 mixture for 4 capillaries 

Component Volume 

Hi-Di Formamide 60 μl 

Matrix Standard BT5 multi cap. 5 μl 
 

 

2. Load 12 μl of the mixture to 96-well plate; e.g., positions A1–D1. 
3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

Example for 16 capillaries (ABI PRISM 3100 Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to Table 
17. 

Table 17. Setup of formamide and Matrix Standard BT5 mixture for 
16 capillaries 

Component Volume 

Hi-Di Formamide 204 μl 

Matrix Standard BT5 multi cap. 17 μl 
 

 

2. Load 12 μl of the mixture to 96-well plate; e.g., positions A1–H1 and  
A2–H2. 

3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 
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Performing a spectral calibration run 

The parameter file for DyeSetG5 must be modified once to achieve successful 
calibration with the Data Collection Software version 1.0.1 or 1.1. 

Spectral parameter 

1. To change settings in the parameter file, go to the following path: 
D:\AppliedBio\Support Files\Data Collection 
SupportFiles\CalibrationData\Spectral Calibration\ParamFiles 

2. Select “MtxSTD{Genescan_SetG5} to open the PAR file. 
3. Change “Condition Bounds Range” to [1.0, 20.0]. 
4. If the calibration was unsuccessful, also change Sensitivity to 0.1 and 

Quality to 0.8. 
5. Select “Save As” in the File menu and save the parameter file under a new 

name; e.g., MtxStd{Genescan_SetG5_BT5}.par. 
Note: Always use this parameter file for spectral calibration runs using 
QIAGEN Matrix Standard BT5. 

Plate Editor for spectral calibration 

1. Place the 96-well plate on the autosampler tray. 
2. Run the ABI PRISM 3100 Data Collection Software. 
3. In Plate View, click “New” to open the Plate Editor dialog box. 
4. Enter a name for the plate. 
5. Select a Spectral Calibration. 
6. Select “96-Well” as plate type, and click “Finish”. 

Table 18. Plate Editor for spectral calibration 

Parameter Settings 

Sample Name Enter name for the matrix samples 

Dye Set G5 

Spectral Run Module Default (e.g., Spect36_POP4) 

Spectral Parameters MtxStd{GeneScan_SetG5_BT5}.par 
(parameters created before) 
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7. Click the column header to select the entire column, and select “Fill Down” 
from the Edit menu to apply the information to the selected samples. Confirm 
by clicking “OK”. 

8. Link the reaction plate on the autosampler tray with the created plate ID and 
start the run. 

9. Upon completion of the run, check in the Spectral Calibration Result dialog 
box that all capillaries have successfully passed calibration (label A).  
If individual capillaries are labeled X, refer to the ABI PRISM 3100-
Avant/3100 Genetic Analyzer User’s Manual. 

10. Click “OK” to confirm completion of the run. 

Checking the matrix 

1. Select “Display Spectral Calibration” from the Tools menu, then “Dye Set” 
and “G5” to review the spectral calibration profile for each capillary. 

2. The quality value (Q value) must be greater than 0.95 and the condition 
number (C value) must be between 1 and 20. Both values must be within the 
predetermined range. 

3. Check for a flat baseline in the matrix samples. There should be 5 peaks 
with heights of 1000–5000 RFU in each matrix sample. 
Note: The optimal range is 2000–4000 RFU. 

4. Check the new matrix with the current samples. There should be no pull-up 
peaks between the dye panels (B, G, Y, R, and O) with the new matrix. 

5. If the calibration failed, follow instructions in the section “Spectral 
parameter” on page 27. 

6. If all capillaries have passed the calibration, the last calibration file for Dye 
Set G5 must be activated manually. Click “Set Active Spectral Calibration” 
under the Tools menu. 

7. Rename the calibration file under Set Matrix Name (e.g., BT5_Date of 
calibration). 

Sample preparation 
1. Set up a mixture of formamide and DNA size standard according to 

Table 19. 
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Table 19. Setup of formamide and DNA size standard mixture 

Component Volume per sample 

Hi-Di Formamide 12 μl 

DNA Size Standard 550 (BTO) 0.5 μl 
 

2. Aliquot 12 μl of the mixture to a tube for each sample to be analyzed. 
3. Add 1 μl PCR product or allelic ladder (diluted, if necessary). 
4. Denature for 3 min at 95°C. 
5. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

6. Load the samples on the tray. 
 
Since injections take place simultaneously on all capillaries, 4 or 16 samples 
must be pipetted onto the plate of multi-capillary analyzers. If fewer samples are 
analyzed, the empty positions must be filled with 12 μl Hi-Di Formamide. 

To ensure a reliable allelic assignment on multi-capillary analyzers, several 
ladders should be run. 

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur especially at 
low temperatures. Ensure ambient conditions are kept as recommended by the 
instrument manufacturer. 

Setting up the GeneScan Software 
1. Edit the default run module in Dye Set G5 once for the first run. Select 

“Module Editor” to open the dialog box. 
2. Select the appropriate Run Module as template from the GeneScan table (see 

Table 20). 
3. Modify the Injection Voltage to 3 kV and the Injection Time to 10 s. 
4. Click “Save As” and enter the name of the new module 

(e.g., 3kV_10s_500bp). Confirm by clicking “OK”. 
5. Click “Close” to exit the Run Module Editor. 
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Table 20. Run Module 3kV_10s_500bp for ABI PRISM 3100-Avant/3100 
Genetic Analyzer 

Parameter Setting 

Run Temperature (°C) Default 

Cap Fill Volume Default 

Maximum Current (A) Default 

Current Tolerance (A) Default 

Run Current (A) Default 

Voltage Tolerance (kV) Default 

Pre-Run Voltage (kV) Default 

Pre-Run Time (s) Default 

Injection Voltage (kV) 3.0 

Injection Time (s) 10* 

Run Voltage (kV) Default 

Number of Steps Default 

Voltage Step Interval Default 

Data Delay Time (s) Default 

Run Time (min) 26† 
 

* Deviating from the standard settings, the injection time may range between 1 and 20 s 
depending on the type of sample. If samples with very high signal intensities are recorded, a 
shorter injection time may be selected. For samples with low DNA content, an injection time 
of up to 20 s may be necessary.  

† The run time for Investigator ESSplex SE GO! was modified in order to be able to analyze 
fragments with lengths of up to 500 bp. 

Starting the run 

1. Place the prepared 96-well plate on the autosampler tray. 
2. Run the ABI PRISM 3100 Data Collection Software. 
3. In Plate View, click “New” to open the Plate Editor dialog box. 
4. Enter a name for the plate. 
5. Select “GeneScan” as the application type. 
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6. Select “96-Well” as plate type, and click “Finish”. 

Table 21. Settings in Plate Editor 

Parameter Settings 

Sample Name Enter name for the matrix samples 

Dyes O 

Color Info Ladder or sample 

Project Name e.g., 3100_Project1 

Dye Set G5 

Run Module 3kV_10s_500bp* 

Analysis Module 1 DefaultAnalysis.gsp 
 

* See Table 20, “Run Module 3kV_10s_500bp for ABI PRISM 3100-Avant/3100 Genetic 
Analyzer”. 

 
7. Complete the table in the Plate Editor and click “OK”. 
8. Click the column header to highlight the entire column and select “Fill Down” 

from the Edit menu to apply the information to the selected samples. 
9. Link the reaction plate on the autosampler tray to the created plate ID and 

start the run. 
10. Upon completion of the run, view the data as Color Data in the Array View 

of the 3100 Data Collection Software or as Analyzed Sample Files under 
D:/AppliedBio/3100/DataExtractor/ExtractRuns. 
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Analysis parameters 
Table 22 lists the recommended analysis parameters. 

Table 22. Recommended analysis parameters for the ABI PRISM 3100-
Avant/3100 Genetic Analyzer 

Parameter Settings 

Analysis Range Start: 2000 

Stop: 10,000 

Data Processing Baseline: Checked 

Multi-component: Checked 

Smooth options: Light 

Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 

G:*   R:* 

O:* 

Min. Peak Half Width: 2 pts 

Polynomial Degree: 3 

Peak Window Size: 11 pts† 

Size Call Range Min: 60 

Max: 550 

Size Calling Method Local Southern Method 

Split Peak Correction None 
 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will be 
detected by the GeneScan or GeneMapper ID Software. Thresholds are usually 50–200 RFU 
and should be determined individually by the laboratory. Recommendation: The minimal peak 
height should be 3-times higher than the background noise of the baseline. 

† Only the setting for Peak Window Size is different to defaults from Applied Biosystems for 
HID analysis. 

 
Note: For information on the use of the recommended Template Files (as 
analysis parameters), refer to the appropriate Investigator Template Files 
User Guide (Genotyper, GeneMapper ID, or GeneMapper ID-X). 
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Protocol: Electrophoresis Using the Applied Biosystems 
3130/3130xl Genetic Analyzer 
For detailed instructions on instrument setup, spectral calibration, or application 
of the ABI PRISM Data Collection Software version 3.0 and the GeneMapper ID 
Software, refer to the Applied Biosystems 3130/3130xl Genetic Analyzers 
Getting Started Guide.  

The system with 4 capillaries is the Applied Biosystems 3130 Genetic Analyzer 
and the system with 16 capillaries is the Applied Biosystems 3130xl Genetic 
Analyzer. 

The virtual filter set Any5Dye is used for combined application of the 5 
fluorescent labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is 
known as BT5.  

The materials required for electrophoresis are given in Table 23. 

Table 23. Materials required for electrophoresis 

Material Specifications 

Capillary 36 cm Capillary Array for Applied Biosystems 
3130/3130xl Genetic Analyzer 

Polymer POP-4 Polymer for Applied Biosystems 3130/3130xl 
Genetic Analyzer 

Buffer 10x Genetic Analyzer Buffer with EDTA 
 

Spectral calibration/matrix generation 
Before conducting DNA fragment size analysis, it is necessary to perform a 
spectral calibration with the 5 fluorescent labels 6-FAM, BTG, BTY, BTR, and 
BTO for each analyzer. The calibration procedure creates a matrix which is 
used to correct the overlapping of fluorescence emission spectra of the dyes.  

Spectral calibration is comprised of the following steps: 

 Preparation of the spectral calibration standards 

 Loading the standards to the 96-well reaction plate (one sample per 
capillary) 

 Creating the instrument protocol for spectral calibration (Protocol Manager) 

 Defining the plate composition in the plate editor (Plate Manager) 
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 Performing a spectral calibration run and checking the matrix 

Preparing the spectral calibration standards 

Example for 4 capillaries (Applied Biosystems 3130 Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to Table 
24. 

Table 24. Setup of formamide and Matrix Standard BT5 mixture for 4 capillaries 

Component Volume 

Hi-Di Formamide 60 μl 

Matrix Standard BT5 multi cap. 5 μl 
 

 

2. Load 12 μl of the mixture into each of the 4 wells in a 96-well plate, e.g., 
positions A1–D1. 

3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

Example for 16 capillaries (Applied Biosystems 3130xl Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to Table 
25. 

Table 25. Setup of formamide and Matrix Standard BT5 mixture for 
16 capillaries 

Component Volume 

Hi-Di Formamide 204 μl 

Matrix Standard BT5 multi cap. 17 μl 
 

 

2. Load 12 μl of the mixture into each of the 16 wells in a 96-well plate, e.g., 
positions A1–H1 and A2–H2. 

3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 
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Performing spectral calibration run 
1. Place the 96-well plate on the autosampler tray. 
2. In the Protocol Manager of the Data Collection Software, open the 

Instrument Protocol window. 
3. Click “New” to open the Protocol Editor dialog box. 
4. Complete the dialog box with information from Table 26 and click “OK”. 

Table 26. Instrument protocol for spectral calibration 

Protocol Editor Settings 

Name User (e.g., Spectral36_POP4_BT5) 

Type SPECTRAL 

Dye Set Any5Dye 

Polymer User (e.g., POP4)* 

Array Length User (e.g., 36cm)* 

Chemistry Matrix Standard 

Run Module Default (e.g., Spect36_POP4_1)* 
 

* Depends on the type of polymer and length of capillary used. 
 
5. Click “New” in the Plate Manager of the Data Collection Software to open 

the New Plate Dialog box. 
6. Enter information from Table 27 and click “OK”. A new table in the Plate 

Editor opens automatically (Table 28). 

Table 27. Plate Editor for spectral calibration (I) 

New plate dialog Settings 

Name e.g., Spectral_BT5_date 

Application Spectral Calibration 

Plate Type 96-well 

Owner Name/ 
Operator Name 

… 
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Table 28. Plate Editor for spectral calibration (II) 

Parameter Settings 

Sample Name Enter name for the matrix samples 

Priority e.g., 100 

Instrument Protocol 1 Spectral36_POP4_BT5 (setting described before) 
 

 
7. Click the column header to select the entire column, and select “Fill Down” 

from the Edit menu to apply the information to the selected samples. Confirm 
by clicking “OK”. 

8. Link the reaction plate on the autosampler tray with the created plate ID 
(position A or B) and start the run. 

 
 

 
Electropherogram of spectral calibration with matrix standard BT5 on an Applied 
Biosystems 3130 Genetic Analyzer. 

 
 

   O            R            Y        G        B 
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Checking the matrix 

1. The quality value (Q value) of each capillary must be greater than 0.95 and 
the condition number range (C value) must be between 1 and 20. 

2. Check for a flat baseline in the matrix samples. As shown in the figure on 
the previous page, there should be 5 peaks with peak heights of about 
1000–5000 RFU in each matrix sample. 
Note: The optimal range is 2000–4000 RFU. 

3. Check the new matrix with the current samples. There should be no pull-up 
peaks between the dye panels (B, G, Y, R, O) with the new matrix. 

4. If calibration failed, use the optimized values of the Matrix Standard BT5 
and repeat the calibration run. 

5. If all capillaries have passed the test, the last calibration file for the Dye Set 
Any5Dye is activated automatically in the Spectral Viewer. Rename the 
calibration file (e.g., BT5_Date of calibration). 

 
Sample preparation 
1. Set up a mixture of formamide and DNA size standard according to Table 

29. 

Table 29. Setup of formamide and DNA size standard mixture 

Component Volume per sample 

Hi-Di Formamide 12.0 μl 

DNA Size Standard 550 (BTO) 0.5 μl 
 

 

2. Aliquot 12 μl of the mixture to a tube for each sample to be analyzed. 
3. Add 1 μl PCR product or allelic ladder (diluted, if necessary). 
4. Denature for 3 min at 95°C. 
5. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

6. Load the samples on the tray. 
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Since injections take place simultaneously on all capillaries, 4 or 16 samples 
must be pipetted onto the plate of multi-capillary analyzers. If fewer samples are 
analyzed, the empty positions must be filled with 12 μl Hi-Di Formamide. 

To ensure a reliable allelic assignment on multi-capillary analyzers, several 
ladders should be run. 

Room temperature may influence the performance of PCR products on multi- 
capillary instruments, so that shoulder peaks or split peaks occur especially at 
low temperatures. Ensure ambient conditions are kept, as recommended by the 
instrument manufacturer. 

Setting up the Data Collection Software 
1. Edit the Run Module once for the first run. In the Module Manager of the 

Data Collection Software, click “New” to open the Run Module Editor dialog 
box. 
Note: Modify the Run Module Default settings from 
“HIDFragmentAnalysis36_POP4_1” to those shown in Table 30. 

2. Modify the Injection Voltage to 3 kV and the Injection Time to 10 s (Table 
30). 

3. Click “Save As”, enter a name for the new Run Module  
(e.g., 3kV_10s_500bp), and confirm by clicking “OK”. 

4. Click “Close” to exit the Run Module Editor. 
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Table 30. Run Module 3kV_10s_500bp for Applied Biosystems 3130/3130xl 
Genetic Analyzer 

Parameter Settings 

Oven Temperature (°C) Default 

Poly Fill Volume Default 

Current Stability (μA) Default 

Pre-Run Voltage (kV) Default 

Pre-Run Time (s) Default 

Injection Voltage (kV) 3.0 

Injection Time (s) 10* 

Voltage Number of Steps Default 

Voltage Step Interval Default 

Data Delay Time (s) Default 

Run Voltage (kV) Default 

Run Time (s) 1560† 
 

* Deviating from the standard settings, the injection time may range between 1 and 20 s 
depending on the type of sample. If samples with very high signal intensities are recorded, a 
shorter injection time may be selected. For samples with low DNA content, an injection time 
of up to 20 s may be necessary.  

† The run time for Investigator ESSplex SE GO! was modified in order to be able to analyze 
fragments with lengths of up to 500 bp. 

Starting the run 

1. Place the prepared 96-well plate on the autosampler tray. 
2. Open the Protocol Manager of the Data Collection Software. 
3. Click “New” in the Instrument Protocol window to open the Protocol Editor 

dialog box and enter the information in Table 31. 
4. Click “OK” to exit the Protocol Editor. 
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Table 31. Settings in Instrument Protocol 

Protocol Editor Settings 

Name Run36_POP4_BT5_26min 

Type REGULAR 

Run Module 3kV_10s_500bp* 

Dye Set Any5Dye 
 

* See Table 30, “Run Module 3kV_10s_500bp for for Applied Biosystems 3130/3130xl 
Genetic Analyzer”. 

 

5. Before each run, it is necessary to create a plate definition. In the Plate 
Manager of the Data Collection Software, click “New” to open the New 
Plate Dialog box. 

6. Enter the information in Table 32. 

Table 32. GeneMapper Plate Editor (I) 

Protocol Editor Settings 

Name e.g., Plate_BT5_Date 

Application Select GeneMapper Application 

Plate type 96-Well 

Owner Name/ 
Operator Name 

… 

 

 
7. Click “OK” and a new table in the Plate Editor opens automatically (Table 

33). 
8. Click the column header to select the entire column. Select “Fill Down” from 

the Edit menu to apply the information to all selected samples. Click “OK”. 
9. In the Run Scheduler, click “Find All”, and select “Link” to link the reaction 

plate on the autosampler tray to the newly created plate record (position A 
or B). 
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Table 33. GeneMapper Plate Editor (II) 

Parameter Settings 

Sample Name Enter the name for the samples 

Priority e.g., 100 (Default) 

Sample Type Sample or Allelic Ladder 

Size Standard e.g., SST-BTO_60-500bp 

Panel e.g., ESSplex SE Plus Panels 

Analysis Method e.g., Analysis_HID_3130 

Snp Set – 

User-defined 1-3 – 

Results Group 1 (Select results group) 

Instrument Protocol 1 Run36_POP4_BT5_26min (setting described 
before) 

 

 
10. Start the run. 
11. During the run, view Error Status in the Event Log or examine the quality of 

the raw data for each capillary in the Capillaries Viewer or the Cap/Array 
Viewer. 

12. View data as an overview in Run History or Cap/Array Viewer of the Data 
Collection Software.  
Run data are saved in the Run Folder of the previously chosen Result Group. 
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Analysis parameters/analysis method 
Table 34 lists the recommended analysis parameters. 

Table 34. Recommended settings for the Applied Biosystems 3130/3130xl 
Genetic Analyzer 

Parameter Settings 

Peak Detection Algorithm Advanced 

Ranges Analysis: Partial Range 

Start Point: 2000; Stop Point: 10,000 

Sizing: All Sizes 

Smoothing and Baselining Smoothing: Light  

Baseline Window: 51 pts 

Size Calling Method Local Southern Method 

Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 

G:*   R:* 

O:* 

Min. Peak Half Width: 2 pts 

Polynomial Degree: 3 

Peak Window Size: 11 pts† 

Slope Thresholds: 0.0 
 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will 
be detected by the GeneMapper ID Software. The thresholds are usually 50–200 RFU and 
should be determined individually by the laboratory. Recommendation: The minimal peak 
height should be 3-times higher than the background noise of the baseline. 

† Only the setting for Peak Window Size is different to defaults from Applied Biosystems for 
HID analysis. 

 
Note: For information on the use of the recommended Template Files (as 
analysis parameters), refer to the appropriate Investigator Template Files 
User Guide (Genotyper, GeneMapper ID, or GeneMapper ID-X). 
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Protocol: Electrophoresis Using the Applied Biosystems 
3500/3500xL Genetic Analyzer 
This Investigator Kit is validated for use on the 3500/3500xL Genetic Analyzer, 
which requires the 3500 Data Collection Software v1 or v2 or HID Updater 
3500 Data Collection v2.0 software. 

Note: The user must be logged on to the PC as local administrator or with 
equivalent access rights to allow data to be written to the appropriate files. 

For detailed instructions on instrument setup, spectral calibration, or application 
of the Applied Biosystems 3500 Series Data Collection Software version 1.0 
and the GeneMapper ID-X Software version 1.2, refer to the Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide.  

The system with 8 capillaries is the Applied Biosystems 3500 Genetic Analyzer 
and the system with 24 capillaries is the Applied Biosystems 3500xL Genetic 
Analyzer. 

The virtual filter set AnyDye is used for combined application of the 5 fluorescent 
labels 6-FAM, BTG, BTY, BTR, and BTO. This matrix standard is known as BT5.  

The materials required for electrophoresis are given in Table 35. 

Table 35. Materials required for electrophoresis 

Material Specifications 

Capillary 36 cm Array for Applied Biosystems 3500/3500xL 
Genetic Analyzer 

Polymer POP-4 for Applied Biosystems 3500/3500xL 
Genetic Analyzer 

Buffer Anode Buffer Container (ABC) 3500 Series 
Cathode Buffer Container (CBC) 3500 Series 

 

Spectral calibration/matrix generation 
Before conducting DNA fragment size analysis, it is necessary to perform a 
spectral calibration with the 5 fluorescent labels 6-FAM, BTG, BTY, BTR, and 
BTO for each analyzer (Table 36). The calibration procedure creates a matrix 
which is used to correct the overlapping of fluorescence emission spectra of the 
dyes.  
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IMPORTANT: Spectral calibration must be performed for each new capillary 
array. 

Spectral calibration comprises the following steps: 

 Preparation of the instrument 

 Preparation of the standard calibration plate 

 Plate assembly and loading the plate in the instrument 

 Software set up of dye set BT5 

 Performing a spectral calibration run 

 Checking the matrix 

Preparation of the instrument 

Before the spectral calibration process, ensure that the spatial calibration has 
been performed. This process is described in detail in the Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide. 

Table 36. The 5 fluorescent labels of BT5 

Color Matrix standard 

Blue (B) 6-FAM 

Green (G) BTG 

Yellow (Y) BTY 

Red (R) BTR 

Orange (O) BTO 
 

Preparation of the standard calibration plate 

Example for 8 capillaries (Applied Biosystems 3500 Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to 
Table 37. 
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Table 37. Setup of formamide and Matrix Standard BT5 mixture for 8 capillaries 

Component Volume 

Hi-Di Formamide 90 μl 

Matrix Standard BT5 multi cap. 10 μl 
 

 

2. Load 10 μl of the mixture into each of the 8 wells in a 96-well plate, e.g., 
positions A1–H1. 

3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

Example for 24 capillaries (Applied Biosystems 3500xL Genetic Analyzer) 

1. Set up a mixture of formamide and Matrix Standard BT5 according to Table 
38. 

Table 38. Setup of formamide and Matrix Standard BT5 mixture for 
24 capillaries 

Component Volume 

Hi-Di Formamide 225 μl 

Matrix Standard BT5 multi cap. 25 μl 
 

 

2. Load 10 μl of the mixture into each of the 24 wells in a 96-well plate, e.g., 
positions A1–H1, A2–H2, and A3–H3.  

3. Denature for 3 min at 95°C. 
4. Snap freeze by placing the plate on ice for 3 min. 

Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

Plate assembly and loading the plate in the instrument 

The necessary steps are described in detail in the Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide. 

Software setup of dye set BT5 

Prior to the spectral calibration, a dye set for the Matrix Standard BT5 must be 
set up. 
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1. To create a new dye set, go to “Library” and select “Analyze”, followed by 
“Dye Sets” and click “Create”. 

2. Enter a “Dye Set Name”, e.g., BT5. 
3. Select “Matrix Standard” as a chemistry and “AnyDye Template” as a dye 

set template. 
4. Disable “Purple” in the field “Arrange Dyes”. Ensure that all other colors are 

enabled. 
5. Under “Calibration Peak Order” the colors need to be arranged as follows: 

5 – blue, 4 – green, 3 – yellow, 2 – red, and 1 – orange. 
6. Do not alter the “Parameter” settings. 
7. Click “Save” to confirm the changes. 
 

 

Setup of dye set BT5. 

Performing a spectral calibration run 

Once the multiwell plates containing the spectral calibration mixture are placed 
in the autosampler tray, the spectral calibration process can be started. 

1. To access the Spectral Calibration screen, select “Maintenance” on the 
Dashboard of the 3500 Series Data Collection software. 
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2. The number of wells in the spectral calibration plate and their location in the 
instrument must be specified. 

3. Select “Matrix Standard” as a chemistry standard and “BT5” for Dye Set 
Name. 

4. (Optional) Enable “Allow Borrowing”. 
5. Click “Start Run”. 

Checking the matrix 

Click a capillary in the table in order to display the results for each capillary 
(spectral data, Quality value, and Condition Number) below the run results table. 

 The quality value (Q value) of each capillary must be greater than 0.8 and 
the number range (C value) must be between 1 and 20. 

 Check the matrix samples for a flat baseline. As shown in the figure, there 
should be 5 peaks with peak heights of about 1000–5000 RFU for each 
matrix sample (Note: The optimal range is 2000–4000 RFU). 

 

 

Electropherogram of spectral calibration of the matrix standard BT5 on an Applied Biosystems 
3500 Genetic Analyzer. 
 

When a spectral calibration is successfully completed, the “Overall” row 
displays green results. If the “Overall” row displays red results, refer to the 
“spectral calibration troubleshooting” section of the Applied Biosystems 
3500/3500xL Genetic Analyzers User Guide. 
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Example of successful spectral calibration of the matrix standard BT5 for all capillaries on an 
Applied Biosystems 3500 Genetic Analyzer. 

 

For each capillary, select and display the spectral and raw data. Check that the 
data meet the following criteria: 

 The order of the peaks in the spectral profile from left to right read orange-
red-yellow-green-blue 

 No extraneous peaks appear in the raw data profile 

 Peak morphology in the spectral profile shows no gross overlaps, dips, or 
other irregularities. Separate and distinct peaks should be visible 

If the data for all capillaries meet the criteria above, click “Accept Results”. If 
any capillary data does not meet the criteria above, click “Reject Results”, and 
refer to the “spectral calibration troubleshooting” section of the Applied 
Biosystems 3500/3500xL Genetic Analyzers User Guide. 

Sample preparation 

1. Set up a mixture of formamide and DNA size standard according to Table 
39. 

Table 39. Setup of formamide and DNA size standard mixture 

Component Volume per sample 

Hi-Di Formamide 12.0 μl 

DNA Size Standard 550 (BTO) 0.5 μl 
 

 

2. Aliquot 12 μl of the mixture to a tube for each sample to be analyzed. 
3. Add 1 μl PCR product or allelic ladder (diluted, if necessary). 
4. Denature for 3 min at 95°C. 
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5. Snap freeze by placing the plate on ice for 3 min. 
Alternatively, the thermal cycler set to 4°C may be used to cool the plate. 

6. Load the samples on the tray. 
 
Since injections take place simultaneously on all capillaries, 8 or 24 samples 
must be pipetted onto the plate of multi-capillary analyzers. If fewer samples are 
analyzed, the empty positions must be filled with 12 μl Hi-Di Formamide. 

To ensure a reliable allelic assignment on multi-capillary analyzers, inject one 
allelic ladder for each set of 24 samples: 

 8-capillary instruments: One allelic ladder per 3 injections 

 24-capillary instruments: One allelic ladder per 1 injection  

Important: The actual room temperature may influence the performance of PCR 
products on multi-capillary instruments, so shoulder peaks or split peaks may 
occur, especially at lower temperatures. Ensure that ambient conditions are 
maintained as recommended by the instrument manufacturer. Also ensure 
buffers are equilibrated to ambient conditions. 

Setting up a run 

If you are using the Investigator ESSplex SE GO! Kit for the first time on an 
Applied Biosystems 3500 Genetic Analyzer, you will first need to set up a 
number of protocols:  

 Instrument Protocol 

 Size Standard 

 QC Protocol 

 Assay 

All protocols can be set up via the Dashboard of the 3500 Series Data 
Collection software. 

1. To set up the Instrument Protocol, go to “Library” and select “Analyze”, 
followed by “Instrument Protocols” and click “Create”. 
Note: Modify the Run Module Default settings from “HID36_POP4” as 
shown in Table 40. 

2. The parameters in Table 40 must be entered or selected. 
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Table 40. Instrument Protocol parameters for Applied Biosystems 3500/3500xL 
Genetic Analyzer 

Parameter Setting 

Application Type HID 

Capillary Length 36 cm 

Polymer POP4 

Dye Set e.g., BT5 

Run Module HID36_POP4 

Protocol Name e.g., Investigator ESSplex SE GO! 

Oven Temperature (°C) Default 

Run Voltage (kV) Default  

PreRun Voltage (kV) Default 

Injection Voltage (kV) 3.0 

Run Time (s) 1300 

PreRun Time (s) Default 

Injection Time (s)  8.0* 

Data Delay (s) Default 

Advanced Options Default 
 

* Deviating from the standard settings, the injection time may range between 1 and 20 s 
depending on the type of sample. If samples with very high signal intensities are recorded, a 
shorter injection time may be selected. For samples with low DNA content, an injection time 
of up to 20 s may be necessary. 

 

3. Click “Save” to confirm the changes. 
4. To set up the Size Standard, go to “Library”, select “Analyze”, followed by 

“Size Standards”, and click “Create”. 
5. The parameters in Table 41 must be entered or selected. 

The DNA Size Standard 550 (BTO) should be used with the following 
lengths of fragments: 60, 80, 90, 100, 120, 140, 160, 180, 200, 220, 
240, 250, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 475, 
500, 525, and 550 bp. 
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Table 41. Size standard parameters 

Parameter Setting 

Size Standard e.g., SST-BTO_60-500bp 

Dye Color Orange 
 

 

6. Click “Save” to confirm the changes. 
7. To set up the QC Protocol, go to “Library” and select “Analyze”, followed by 

“QC Protocols”, and click “Create”. 
8. The parameters in Table 42 must be entered or selected. 

Table 42. QC Protocol parameters 

Parameter Setting 

Protocol Name e.g., BTO_550 

Size Standard SST-BTO_60-500bp (from Table 41) 

Sizecaller SizeCaller v1.1.0 
 

 

9. Go to “Analysis Settings”, followed by “Peak Amplitude Threshold” and 
disable “Purple”. Ensure that all other colors are enabled. 
Check the recommended analysis settings in Table 45. All other settings 
should remain as “Default”. 

10. Click “Save” to confirm the changes. 
11. To set up an Assay, go to “Library” and select “Manage”, followed by 

“Assays”, and click “Create”. 
12. To analyze Investigator ESSplex SE GO! fragments, the parameters in 

Table 43 must be selected. 
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Table 43. Assay parameters 

Parameter Setting 

Assay Name e.g., Investigator ESSplex SE GO! 

Color Default 

Application Type HID 

Instrument Protocol e.g., Investigator ESSplex SE GO! (from  
Table 40) 

QC Protocols e.g., BTO_550 (from Table 42) 
 

 

13. Click “Save” to confirm the changes. 

Starting the run 

1. In the Dashboard, click “Create New Plate”.  
2. Go to “Define Plate Properties” and select “Plate Details”. Select or enter the 

parameters in Table 44. 

Table 44. Plate properties 

Property Setting 

Name e.g., Investigator ESSplex SE GO! 

Number of Wells 96 

Plate Type HID 

Capillary Length 36 cm 

Polymer POP4 
 

 

3. Click “Assign Plate Contents” to confirm the changes. 
4. Enter the designated sample name in each well containing a sample or 

allelic ladder. This will identify the well positions of each sample for the data 
collection and processing. 
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5. Choose the correct Assay for the analysis. If you followed the steps under 
“Setting up the Run”, this would be Investigator ESSplex SE GO! from step 
11. All named wells on the plate must have an assigned assay.  

6. Select the wells for which to specify an assay. Check the box next to the 
assay name to assign it to the selected wells.  

7. (Optional) Repeat for file name conventions and results group. 
8. If not already done, load the assembled plate to the instrument and close the 

instrument door to re-initialize the instrument. Then click “Link Plate for 
Run”. In the next screen, enter the desired Run Name and click “Start Run”. 
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Analysis parameters/analysis method 
Table 45 lists the recommended analysis parameters in the worksheet Peak 
Detector. 

Table 45. Recommended settings for the Applied Biosystems 3500/3500xL 
Genetic Analyzer 

Parameter Settings 

Peak Detection Algorithm Advanced 

Ranges Analysis: Partial Range 

Start Point: 1000; Stop Point: 20,000 

Sizing: All Sizes 

Smoothing and Baselining Smoothing: Light  

Baseline Window: 51 pts 

Size Calling Method Local Southern Method 

Peak Detection Peak Amplitude Thresholds 

B:*    Y:* 

G:*   R:* 

O:* 

Min. Peak Half Width: 2 pts 

Polynomial Degree: 3 

Peak Window Size: 11 pts† 

Slope Thresholds: 0.0 
 

* The peak amplitude threshold (cutoff value) corresponds to the minimum peak height that will 
be detected by the GeneMapper ID-X Software. The thresholds are usually 50–200 RFU and 
should be determined individually by the laboratory. Recommendation: The minimal peak 
height should be three-times higher than the background noise of the baseline. 

† Only the setting for Peak Window Size is different to defaults from Applied Biosystems for 
HID analysis. 
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Protocol: Analysis 
For general instructions on automatic sample analysis, refer to the appropriate 
User Guides for GeneMapper ID-X, GeneMapper ID, or GeneScan Software. 

Finding the exact lengths of the amplified products depends on the device type, 
the conditions of electrophoresis, as well as the DNA size standard used. Due to 
the complexity of some loci, determining the size should be based on evenly 
distributed references. The DNA Size Standard 550 (BTO) should be used with 
the following lengths of fragments: 60, 80, 90, 100, 120, 140, 160, 180, 
200, 220, 240, 250, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 
475, 500, 525, and 550 bp. 
 

 
 

Figure 1. Electropherogram of the DNA Size Standard 550 (BTO), fragments with lengths in bp. 

Analysis Software 
Allele allocation should be carried out using suitable analysis software (e.g., 
GeneMapper ID-X, GeneMapper ID, or Genotyper Software) in combination 
with the Investigator Template Files available for download from 
www.qiagen.com; see Table 46 and Table 47.  

The recommended Investigator Template File for Genotyper Software is the 
ESSplex SE. 
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Table 46. Recommended Investigator Template Files for GeneMapper ID  

File type File name 

Panels ESSplex SE Plus_Panels 

BinSets ESSplex SE Plus_Bins 

Size standard SST-BTO_60–500bp 

Analysis Method Analysis_HID_310 

Analysis_HID_3130 

Plot Settings Plots_5dyes 

Table Settings Table for 2 alleles 

Table for 10 alleles 
 

Panels and BinSets must always be used; other template files are optional. 

Table 47. Recommended Investigator Template Files for GeneMapper ID-X  

File type File name 

Panels ESSplex SE Plus_Panels_x 

BinSets ESSplex SE Plus_Bins_x 

Stutter ESSplex SE Plus_Stutter_x 

Size standard SST-BTO_60–500bp 

Analysis Method Analysis_HID_310_200rfu 

Analysis_HID_3130_200rfu 

Analysis_HID_3500_200rfu 

Plot Settings Plots_5dyes 

Table Settings 310 Data Analysis/31xx Data Analysis 
 

Panels and BinSets must always be used; other template files are optional.  

Controls 
The alleles listed in Table 48 represent the Control DNA 9948 (included in the 
Investigator ESSplex SE GO! Kit) and DNA from other commercially available 
standard cell lines. 
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Table 48. Allele assignment of the Investigator ESSplex SE GO! Kit 

 
Locus 

CCR  
9948 

CCR  
9947A 

CCR  
3657 

Amelogenin X/Y X/X X/Y 

D1S1656 14/17 18.3/18.3 13/18.3 

D2S441 11/12 10/14 14/14 

D2S1338 23/23 19/23 18/22 

D3S1358 15/17 14/15 16/18 

D8S1179 12/13 13/13 15/16 

D10S1248 12/15 13/15 14/16 

D12S391 18/24 18/20 18/19 

D16S539 11/11 11/12 13/13 

D18S51 15/18 15/19 12/20 

D19S433 13/14 14/15 13/14 

D21S11 29/30 30/30 28/29 

D22S1045 16/18 11/14 11/17 

FGA 24/26 23/24 18/23 

SE33 23.2/26.2 19/29.2 22.2/27.2 

TH01 6/9.3 8/9.3 7/9.3 

vWA 17/17 17/18 14/19 
 

 

For further confirmation, the table above displays the alleles of the reference DNA 
purchased from Coriell Cell Repositories (CCR), as well as 3 reference DNAs 
purchased from CCR and ATCC up to the standard of Szibor et al. (2003). 

Alleles 
Table 49 shows the alleles of the allelic ladder. All analyses were performed 
using POP-4 polymer (Table 49 and Figure 2). Different analysis instruments, 
DNA size standards, or polymers may result in different fragment lengths. In 
addition, a visual alignment with the allelic ladder is recommended. 
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Scaling 

 Horizontal: 70–480 bp  

 Vertical: Depending on signal intensity  

 

 
 
Figure 2. Electropherogram of the allelic ladder ESSplex SE GO! analyzed on an Applied 
Biosystems 3500 Genetic Analyzer. Allele assignment was performed using Investigator 
IDproof Software. 
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Table 49. Allelic ladder fragments included in the Investigator ESSplex SE GO! 
Kit 

Locus Dye label Repeat numbers of allelic ladder 

Amelogenin 6-FAM X, Y 

TH01 6-FAM 4, 5, 6, 7, 8, 9, 9.3, 10, 10.3, 13, 13.3 

D3S1358 6-FAM 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 
21 

vWA 6-FAM 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22

D21S11 6-FAM 
24, 24.2, 25, 26, 26.2, 27, 28, 28.2, 29, 
29.2, 30, 31, 31.2, 32, 32.2, 33, 33.2, 34, 
34.2, 35, 36, 36.2, 37 

D16S539 BTG 8, 9, 10, 11, 12, 13, 14, 15 

D1S1656 BTG 10, 11, 12, 13, 14, 15, 16, 17, 17.3, 18.3, 
19.3 

D19S433 BTG 6.2, 10, 11, 12, 12.2, 13, 13.2, 14, 14.2, 15, 
15.2, 16, 16.2, 17, 17.2 

SE33 BTG 6.3, 9, 10, 11, 12, 13, 13.2, 14, 15, 16*, 17, 
18, 18.2, 19, 19.2, 20, 20.2, 21, 21.2, 22.2, 
23.2, 24.2, 25, 25.2, 26.2, 27.2*, 28.2, 29.2, 
30.2, 31.2, 32, 32.2, 33, 33.2, 34, 35, 36, 
36.2, 37, 38, 49 

D10S1248 BTY 10, 11, 12, 13, 14, 15, 16, 17, 18, 19 

D22S1045 BTY 10, 11, 12, 13, 14, 15, 16, 17, 18, 19 

D12S391 BTY 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26
 

Table continued on next page. 
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Table 49. continued from previous page. 

Locus Dye label Repeat numbers of allelic ladder 

D8S1179 BTY 7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19

D2S1338 BTY 14, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 
27, 28 

D2S441 BTR 8, 10, 11, 12, 13, 14, 15, 16 

D18S51 BTR 8, 9, 10, 10.2, 11, 12, 13, 14, 15, 16, 17, 
17.2, 18, 18.2, 19, 20, 21, 21.2, 22, 23, 24, 
25, 26, 27, 28 

FGA BTR 14, 16, 17, 18, 19, 20, 21, 21.2, 22, 23, 23.2, 
24, 25, 26, 27, 28, 29, 30, 30.2, 31.2, 33, 34, 
37.2, 42.2, 44.2, 45.2, 47.2, 50.2 

 

* Alleles are heightened within the allelic ladder for better orientation. 

 
For information about known microvariants not contained in the Investigator 
ESSplex SE GO! allelic ladder, see the National Institute of Standards and 
Technology (NIST) web site (www.cstl.nist.gov/biotech/strbase/). 
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Troubleshooting Guide 
This troubleshooting guide may be helpful in solving any problems that may 
arise. For more information, see also the Frequently Asked Questions page at 
our Technical Support Center: www.qiagen.com/FAQ/FAQList.aspx. The 
scientists in QIAGEN Technical Services are always happy to answer any 
questions you may have about either the information and protocols in this 
handbook or sample and assay technologies (for contact information, see back 
cover or visit www.qiagen.com). 

 Comments and suggestions 

Many samples show off-scale alleles 

 PCR cycle number too 
high 

Determine optimal cycle number by running a 
representative batch of samples. Re-inject off-
scale samples occurring under optimal cycle 
conditions using a reduced injection time 

Many samples show faint or no signal 

 PCR cycle number too 
low 

Determine optimal cycle number by running a 
representative batch of samples. 

Unbalanced profiles, low signals 

a) Incorrect volume of Fast 
Reaction Mix or Primer 
mix 

Check reaction setup and repeat amplification 

b) Master mix not 
vortexed before 
distribution 

Vortex master mix thoroughly 

c) Sample size too large Do not use more than one 1.2 mm punch, or 
punches with larger diameter 

Swab samples show low signal for high-molecular-weight markers 

 Lysis incomplete Perform optional lysis at 95°C 
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 Comments and suggestions 

Sample preparation  

 Sample signal intensity 
must be increased 

Reduce the volume of the DNA Size Standard 
550 (BTO) to peak heights of about 500 RFU.  

Purify the PCR products before starting the 
analysis. We recommend the MinElute® PCR 
Purification Kit (QIAGEN, cat. nos. 28004 and 
28006) for rapid and effective purification (see 
“Ordering Information”, page 67) 

Matrix/spectral calibration is not appropriate 

 There are pull-up peaks 
between the dye panels 
(B, G, Y, R, O) with the 
current matrix/ spectral 
calibration 

This matrix cannot be used for the analysis. 
Repeat the matrix generation/spectral 
calibration. Be sure to carefully follow the correct 
protocol for the specific analysis instrument. 

Many peaks are labeled as off-ladder (OL) alleles in the samples 

a) DNA Size Standard 
550 (BTO) was not 
defined or identified 
correctly 

Click the orange “Size Match Editor“ icon in the 
upper toolbar or the GeneMapper ID or 
GeneMapper ID-X Software. Mark the orange 
fragments of all samples.  

Always use the DNA Size Standard 550 
included in Investigator Human Identification PCR 
Kits. 

b) Signal intensities are 
too high. If the peak 
heights of the samples 
are outside the linear 
detection range 
(>4000 RFU/>5000 
RFU)*, stutters, split 
peaks, and artifacts 
may be increased 

Reduce the injection time in increments to a 
minimum of 1 s, reduce the amount of the PCR 
amplification product for analysis, or reduce the 
quantity of DNA for PCR. 

 

* >4000 RFU for the ABI PRISM 310 Genetic Analyzer; >5000 RFU for the Applied Biosystems 
3100/3130/3500 Genetic Analyzer. 
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 Comments and suggestions 

c) Bubbles in the capillary 
lead to pull-up peaks in 
all color panels 
(“spikes”) that result in 
allele misnomer 

Repeat electrophoresis to confirm results. 

d) Differences in the run 
performance among 
the capillaries of a 
multi-capillary analyzer 
may result in allelic 
assignment shift 

For reliable allelic assignment on multi-capillary 
analyzers, a number of allelic ladders should be 
run. 

 

Injection/file of the allelic ladder is not appropriate 

a) An additional signal 
can be identified as 
peak of the allelic 
ladder because of 
dysfunctions during the 
electrophoresis. If 
peaks of the allelic 
ladder are miscalled, 
the ladder cannot be 
used for the analysis 

Use a different injection/file of the allelic ladder 
and check the data of the analyzed sizes from 
the Size Standard (in bp) of the allelic ladder.  

Always use the DNA Size Standard 550 for 
Investigator Human Identification PCR Kits. 

b) One peak of the allelic 
ladder is below the 
peak detection value 
(50–200 RFU) of the 
analysis method used, 
and thus, is not 
identified 

The allelic ladder must be loaded onto the 
analysis instrument at a higher concentration 
than samples to be analyzed.  

Alternatively, allelic ladder data can be 
analyzed with a lower peak detection value in 
Analysis Software. 

c) One peak of the allelic 
ladder is not identified 
because it is outside the 
expected size range of 
the software (in bp) 

Compare the length of the fragments (in bp) of 
the first allele in one color of the allelic ladder 
with the corresponding value in the categories. 
Then compare it with the other alleles. 
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 Comments and suggestions 

d) Point alleles are not 
found 

Point alleles are alleles with at least 1 bp 
difference to the next integer allele. Check the 
settings of the analysis method. Lower the Peak 
Window Size value to 11 points. 
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Appendix: Interpretation of Results 
Post-PCR analysis and automatic allele assignment with suitable analysis 
software ensure a precise and reliable discrimination of alleles. 

General procedure for the analysis 

1. Check the DNA size standard. 
2. Check the allelic ladder. 
3. Check the positive control. 
4. Check the negative control. 
5. Analyze and interpret the sample data. 

Pull-up peaks 

Pull-up peaks may occur if peak heights are outside the linear detection range 
(see “Troubleshooting Guide”, page 61), or if an incorrect matrix was applied. 
They appear at positions of specific peaks in other color channels, typically with 
lower signal intensities. Peak heights should not exceed thresholds in order to 
prevent pull-up peaks.  
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Stutter peaks 

The occurrence of stutter peaks depends on the sequence of the repeat structure 
and the number of alleles. n –4 peaks are caused by a loss of a repeat unit during 
amplification of tetranucleotide STR motifs, caused by slippage effects of the Taq 
DNA Polymerase, whereas n –3 peaks appear particularly during amplification 
of the trinucleotide STR motif D22S1045. These peaks should be interpreted using 
the Investigator Template Files for GeneMapper ID-X, GeneMapper ID, and 
Genotyper Software. 

Template-independent addition of nucleotides 

Because of its terminal transferase activity, the Taq DNA Polymerase may cause 
incomplete adenylation at the 3'-end of the amplified DNA fragments. The artifact 
peak is one base shorter than expected (–1 peaks). All primers included in the 
Investigator ESSplex SE GO! Kit are designed to minimize these artifacts. Peak 
height of the artifact correlates with the amount of DNA. Laboratories should 
define their own limits for analysis of the peaks. 

Artifacts  

Room temperature may influence the performance of PCR products on multi-
capillary instruments, so that shoulder peaks or split peaks occur. If shoulder or 
split peaks appear, we recommend injecting the sample again. Ensure ambient 
conditions are kept, as recommended by the instrument manufacturer. Ensure 
buffers are equilibrated to ambient conditions as well. 
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Ordering Information 
Product Contents Cat. no. 

Investigator ESSplex SE 
GO! Kit (200) 

Primer Mix, Fast Reaction Mix including 
HotStarTaq Plus DNA Polymerase, 
Control DNA, allelic ladder ESSplex SE 
GO! and DNA size standard 550 
(BTO) 

381566 

Investigator ESSplex SE 
GO! Kit (1000) 

Primer Mix, Fast Reaction Mix including 
HotStarTaq Plus DNA Polymerase, 
Control DNA, allelic ladder ESSplex SE 
GO! and DNA size standard 550 
(BTO) 

381568 

Accessories   

Investigator STR GO! 
Lysis Buffer (200) 

Lysis buffer for 200 swab samples 386516 

Investigator STR GO! 
Punch Buffer (200)*        

Lysis buffer for 200 samples of 
epithelial cells on paper 

386526 

Matrix Standard BT5 
multi cap. (25) 

Matrix standard 6-FAM, BTG, BTY, BTR, 
and BTO 

386123 

Matrix Standard BT5 
multi cap. (50) 

Matrix standard 6-FAM, BTG, BTY, BTR, 
and BTO 

386125 

DNA Size Standard 
550 (BTO) (100) 

DNA Size Standard 550 (BTO) for 100 
reactions 

386015 

Related products  

Investigator Human Identification PCR Kits  

Investigator 24plex QS 
Kit (100)* 

Primer mix, Fast Reaction Mix 2.0, 
Control DNA, allelic ladder 24plex, 
DNA size standard 550 (BTO), and 
nuclease-free water 

382415 

Investigator 24plex 
GO! Kit (200)* 

Primer mix, Fast Reaction Mix 2.0, 
Control DNA, allelic ladder 24plex, 
DNA size standard 550 (BTO) 

382426 

 

* Larger kit sizes are available; please inquire. 
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Product Contents Cat. no. 

Investigator ESSplex SE 
Plus Kit (100)* 

Primer mix, Fast Reaction Mix including 
HotStarTaq Plus DNA Polymerase, 
Control DNA, allelic ladder ESSplex SE 
Plus, DNA size standard 550 (BTO), 
and nuclease-free water 

381545 

Investigator IDplex Plus 
Kit (100)* 

Primer mix, Fast Reaction Mix including 
HotStarTaq Plus DNA Polymerase, 
Control DNA, allelic ladder IDplex Plus, 
DNA size standard 550 (BTO), and 
nuclease-free water 

381625 

Investigator ESSplex 
Plus Kit (100)* 

Primer mix, Fast Reaction Mix including 
HotStarTaq Plus DNA Polymerase, 
Control DNA, allelic ladder ESSplex 
Plus, DNA size standard 550 (BTO), 
and nuclease-free water 

381535 

Investigator IDplex GO! 
Kit (200)* 

Primer Mix, Fast Reaction Mix including 
HotStarTaq Plus DNA Polymerase, 
Control DNA, allelic ladder IDplex GO! 
and DNA size standard 550 (BTO) 

381636 

Investigator HDplex Kit 
(100) 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

381215 

Investigator Triplex AFS 
QS Kit (400) 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

380317 

Investigator Triplex DSF 
Kit (400) 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

380327 

 

* Larger kit sizes are available; please inquire. 
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Product Contents Cat. no. 

Investigator Argus X 12 
Kit (25)* 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

383213 

Investigator Argus Y 12 
QS Kit (100) 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

383615 

Investigator DIPplex Kit 
(100) 

Primer mix, reaction mix, DNA 
Polymerase, Control DNA, allelic 
ladder, DNA size standard, and 
nuclease-free water 

384015 

Investigator Quantiplex 
Kit (200) 

Primer mix IC FQ, reaction mix FQ, 
control DNA Z1, dilution buffer 

387016 

Investigator Quantiplex 
HYres Kit (200) 

Primer mix IC YQ, reaction mix YQ, 
control DNA Z1, dilution buffer 

387116 

DNA extraction and purification   

QIAamp® DNA 
Investigator Kit (50)* 

50 QIAamp MinElute Columns, 
Proteinase K, Carrier RNA, Buffers, 
Collection Tubes (2 ml) 

56504 

EZ1® DNA Investigator 
Kit (48) 

Reagent Cartridges (DNA Investigator), 
Disposable Filter-Tips, Disposable Tip-
Holders, Sample Tubes (2 ml), Elution 
Tubes (1.5 ml), Buffer G2, Proteinase K, 
Carrier RNA 

952034 

MinElute PCR 
Purification Kit (50)*1 

50 MinElute Spin Columns, Buffers, 
Collection Tubes (2 ml) 

28004 

For up-to-date licensing information and product-specific disclaimers, see the 
respective QIAGEN kit handbook or user manual. QIAGEN kit handbooks and 
user manuals are available at www.qiagen.com or can be requested from 
QIAGEN Technical Services or your local distributor.  

 

* Larger kit sizes are available; please inquire. 
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Notes 

  



 

 

Trademarks: QIAGEN®, QIAamp®, EZ1®, HotStarTaq®, Investigator®, MinElute®, Rotor-Gene® (QIAGEN Group); ABI PRISM®, Applied Biosystems®, 
6-FAM™, GeneAmp®, GeneMapper®, GeneScan®, Genotyper®, Hi-Di™, POP-4™ (Applera Corporation and its subsidiaries); Eppendorf®, 
Mastercycler® (Eppendorf AG); GenBank ® (US Department of Health and Human Services). Registered names, trademarks, etc. used in this 
document, even when not specifically marked as such, are not to be considered unprotected by law. 

Limited License Agreement for the Investigator ESSplex SE GO! Kit 

Use of this product signifies the agreement of any purchaser or user of the product to the following terms: 

1. The product may be used solely in accordance with the protocols provided with the product and this handbook and for use with components 
contained in the kit only. QIAGEN grants no license under any of its intellectual property to use or incorporate the enclosed components of this 
kit with any components not included within this kit except as described in the protocols provided with the product, this handbook, and 
additional protocols available at www.qiagen.com. Some of these additional protocols have been provided by QIAGEN users for QIAGEN 
users. These protocols have not been thoroughly tested or optimized by QIAGEN. QIAGEN neither guarantees them nor warrants that they do 
not infringe the rights of third-parties.  

2. Other than expressly stated licenses, QIAGEN makes no warranty that this kit and/or its use(s) do not infringe the rights of third-parties. 

3. This kit and its components are licensed for one-time use and may not be reused, refurbished, or resold. 

4. QIAGEN specifically disclaims any other licenses, expressed or implied other than those expressly stated. 

5. The purchaser and user of the kit agree not to take or permit anyone else to take any steps that could lead to or facilitate any acts prohibited 
above. QIAGEN may enforce the prohibitions of this Limited License Agreement in any Court, and shall recover all its investigative and Court 
costs, including attorney fees, in any action to enforce this Limited License Agreement or any of its intellectual property rights relating to the kit 
and/or its components. 

For updated license terms, see www.qiagen.com. 

HB-1575-004 © 2015 QIAGEN, all rights reserved. 
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www.qiagen.com 

Australia  techservice-au@qiagen.com 

Austria  techservice-at@qiagen.com 

Belgium  techservice-bnl@qiagen.com 

Brazil  suportetecnico.brasil@qiagen.com 

Canada  techservice-ca@qiagen.com 

China  techservice-cn@qiagen.com 

Denmark  techservice-nordic@qiagen.com 

Finland  techservice-nordic@qiagen.com 

France  techservice-fr@qiagen.com 

Germany  techservice-de@qiagen.com 

Hong Kong  techservice-hk@qiagen.com 

India  techservice-india@qiagen.com 

Ireland  techservice-uk@qiagen.com 

Italy  techservice-it@qiagen.com 

Japan  techservice-jp@qiagen.com 

Korea (South)  techservice-kr@qiagen.com 

Luxembourg  techservice-bnl@qiagen.com 

Mexico  techservice-mx@qiagen.com 

The Netherlands  techservice-bnl@qiagen.com 

Norway  techservice-nordic@qiagen.com 

Singapore  techservice-sg@qiagen.com 

Sweden  techservice-nordic@qiagen.com 

Switzerland  techservice-ch@qiagen.com 

UK  techservice-uk@qiagen.com 

USA  techservice-us@qiagen.com 


